
Overview

Recording vinyl LPs to CDs or MP3 Files

To record a vinyl LP to convert to a CD or group of MP3 Files you need to use a 'WAV file recorder' to 
store the recording as a WAV format file on your hard disk. Most general purpose WAV recorders are 
packed with functions. As a result, they tend to be complicated and time-consuming to configure and use. 

In contrast, LP Recorder has been designed with one purpose in mind - to record vinyl LPs. Connect the 
tape or line output from your stereo to the line input of your soundcard, enter a filename, select the 
recording source and press the record button.

Special features of LP Recorder suited to recording vinyl are:

· Automatically adjusts optimum recording levels to avoid distortion
· Auto start and auto stop for easy operation
· Visual level meter can be used to check recording levels before AND during recording
· Level meter is displayed even if the soundcard does not support meters
· Large volume slider with numeric values for precise settings
· Skipping and clipping protection and detection
· Pause recording - useful for recording a selection of tracks from different LPs
· The remaining recording time, based on the free space on your disk, is displayed
· The recorded file is ready for further processing as soon as the recording has finished
· Produces an LP Ripper-compatible Tracks (TRK) File
· Minimum number of settings for easy configuration





Getting Started
Before you start, you will need:

· Free hard disk space

You will need approximately 300Mbytes of free hard disk space to record 30 minutes of music 
equivalent to CD quality.

· A turntable / amplifier connected to the sound card installed in your computer.

Connect the tape output or line output of your stereo amplifier to the line input of your sound card. If 
you do not have a suitable cable, you can purchase one from Tandy / Radio Shack or a similar 
electronic store.

NOTE: Do not use the microphone input of your soundcard. It is too sensitive and will result in loud 
distorted sound.

NOTE: You cannot connect your turntable directly to the soundcard as the signal is not strong enough. 
If you are not able to connect your turntable via your main stereo amplifier, you could purchase a 
'Phono Preamp' to match the signal levels required. These vary in cost from as low as $US20 to a few 
hundred dollars for the connoisseur 'Hi-Fi' version.

For each LP that you want to record as a WAV file:

· Start LP Recorder.

The status bar displays 'Preview'.

· Specify a Directory

Enter the name of the Windows directory where you want to save the WAV file. The recording time 
available, based on the amount of free disk space on that drive, is displayed.

· Specify a Filename

Enter the name of the WAV file that you are going to create. To ensure compatibility with other sound 
processing and CD writing programs you should give the filename a .wav extension e.g. myfile.wav

· Select the Recording Input

Select 'Line-in' (just called 'Line' with some soundcards) from the combo box above the time display.

· Set the Recording Level 

Uncheck the Mute checkbox
Check the Auto Start/Stop checkbox
Check the Auto Level checkbox

Play one of the loudest parts of the LP and adjust LP Recorder's volume level so that the level meter 
does not reach the highest level.    If the level meter doesn't display any activity, make sure that line-in 
is selected by setting the Windows Recording Control

· Press the Record Button 



The status bar displays 'Waiting' and the record button changes colour to yellow.

· Play the LP.

As soon as the stylus touches the LP, the recording should start. The status bar displays 'Recording', 
the record button changes colour to green and the recording time so far is shown.

· Stop playing the LP.

When the LP has finished playing, lift the stylus and the recording should automatically stop. The 
record button changes colour to red.
 

· Check the recording

Click on the Player tab and press the Play button. The WAV file you have recorded is played.

· Separating Tracks

Before you save the recording to CD or convert it to MP3 files, you will need to split the WAV file into a 
separate WAV file for each track. The companion program from CFB Software, LP Ripper, was 
designed especially for this task. Check the CFB Software Website for details.

Alternatively, but less convenient, you could use LP Recorder to just record one track at a time.



Setting the Windows Recording Control
The Windows Audio Mixer / Volume Control / Recording Control program controls the combination of 
audio inputs and outputs to your soundcard. This includes the inputs that are used for recording.

If you can hear your LP playing through the computer speakers but the level meter displays nothing and 
the recorded file just contains silence, check that your recording input e.g. Line-In, is selected in 
Windows. To do this:

1. Start the Windows Volume Control by double-clicking on the speaker icon  in the Windows 
System Tray - normally at the bottom right hand corner of your screen.

2. Select Properties from the Options menu.

3. Select Recording from the group box and check all of the volume controls shown.



4. Click on OK.

5. Check the select box on the Line-in volume control. (This is VERY important!)

6. Select Exit from the Options menu to close the Windows Recording Control. The settings are saved 
until they are changed again.



CFB Software Web Site
The CFB Software Web Site can be found on the Internet at:

http://www.cfbsoftware.com.au

Visit the site to:

- Get the most up-to-date information on LP Ripper and LP Recorder
- Download the latest versions
- Find links to Noise-reduction software and MP3 Encoders
- Order LP Recorder on-line using a credit card



Recorder Controls
When you start LP Recorder, the recorder tab is selected and the recorder controls are displayed.

'Preview' is displayed in the status bar. 

Selecting the Recording Input
The combo box above the time display has a list of the recording sources of your soundcard e.g. 
Microphone, CD Audio, Line-in, MIDI etc. Select the source corresponding to the input on your soundcard 
that you have connected to the line-out or tape-out output of your stereo amplifier. Normally, when 
recording LPs, this would be the 'Line-in' input (simply called 'Line' on some soundcards).

Setting the Recording Level
To set the optimum recording level, play the loudest parts of the LP you are going to record and adjust the 
Volume slider control while observing the level meter. The meter should display just less than the 
maximum level when the loudest section of the LP is playing. If you check the Auto Level checkbox, the 
volume control automatically lowers itself if the level is too high.

Specifying the WAV Filename
Enter the name of the directory where you want to store the recorded WAV file in the directory box. Enter 
the name that you want to give to the WAV file in the filename box. To ensure compatibility with other 
sound processing and CD writing programs you should give the filename a .wav extension e.g. myfile.wav

Start Recording



 Click the record button when you are ready to start the recording.

If you have checked the Auto Start / Stop checkbox, the Status bar displays 'Waiting' and the record 
button changes colour to yellow. The recording does not actually start until you have lowered the stylus 
onto the LP.

Once the recording has started, the Status bar displays 'Recording', the record button changes colour to 
green and the recording time so far is shown in minutes and seconds.

Pause Recording

 To temporarily stop the recording, click the pause button. The record button changes colour to 
yellow. Click the pause button again to restart the recording. This is useful if you are recording a selection 
of tracks from different LPs. 

NOTE: Once the recording has started, clicking the record button also pauses and restarts the recording.

Stop Recording

 When the LP has finished playing, click the stop button. 

If you have pressed the Auto Start / Stop checkbox, the recording automatically stops when you lift the 
stylus. 'Preview' is displayed in the Status bar.

Recording Quality
The recorded WAV file is a 44.1Khz 16-bit Stereo file suitable for writing to a recordable audio format CD 
using the software supplied with your CD Writer.



Auto Start / Stop
When the Auto Start / Stop checkbox is checked, LP recorder automatically starts the recording when the 
stylus is lowered onto the LP and stops the recording when the stylus is raised from the LP. Situations 
where this is useful include:

a. The turntable is located some distance from the computer and you are operating the turntable 
manually. Without Auto Start / Stop, by the time you get back to the computer to start the recording the 
music would have already started.

b. If your turntable automatically lifts the stylus at the end of the LP you can leave the recording 
unattended. Without Auto Start / Stop you would risk recording a long period of silence if you didn't return 
soon after the music stopped.

You will need to set the Start / Stop Level to suit your system using the Preferences selection from the 
Options menu before using this feature.

When LP Recorder Auto Start / Stop is checked, click on the record button BEFORE you lower the stylus 
onto the groove. The recording will start when the stylus touches the surface and will automatically stop 
when the stylus is lifted from the surface. i.e. it is detecting the difference between just surface noise and 
no stylus motion at all.

Auto Start / Stop should work similarly when recording from tapes or cassettes, as long as there is a 
significant difference in noise level between when the tape is stopped and when it is in motion i.e. no 
signal vs. tape hiss.



Player Controls
When you click on the Player tab, the controls to play a WAV file are displayed. 

Specifying the WAV Filename
Enter the name of the directory where the recorded WAV file is stored, in the directory box. Enter the 
name of the WAV file in the filename box. To ensure compatibility with other sound-processing and CD-
writing programs you should give the filename a .wav extension e.g. myfile.wav

Start Playing

 Click the play button to start playing the recorded WAV file. The time display shows how many 
minutes and seconds the recording has been playing and how long it is until it finishes. 

Pause Playing

 Click the pause button to temporarily stop playing the recorded WAV file. Click on the pause button 
again to restart playing the file.

Stop Playing

 Click the stop button to stop playing the recorded WAV file. 





Skipping and Clipping
Two common problems that can occur with recording software are 'skipping' and 'clipping'. LP Recorder 
attempts to detect and prevent these problems.

Skipping

If other resource-intensive programs are running on the computer during recording 'skipping' can occur. 
The effect is similar to that heard on a portable CD player when it is jarred - a short gap or jump is heard 
in the music. This occurs when LP Recorder has not been able to store the music recorded so far, before 
it receives more samples from the sound card. 

The solution is similar to that used in the anti-skip devices in the portable CD players. LP Recorder 
temporarily saves the recording in RAM so that an interruption can last for as long as ten seconds before 
any of the recording is lost. 

Generally, interruptions only last for at most 1 or 2 seconds and skipping does not occur. If, however, an 
ill-behaved program does cause skipping, the number of skips is displayed on the status bar. It is also 
logged with the corresponding track time in the trace file.

NOTE: If skips were not detected during recording but can be heard during playback, it is most likely that 
it is the playback software that is being interrupted. This can be easily checked because the skips would 
be heard in different places each time the recording is played. The solution is to try a different player or to 
avoid running the program that is the cause of interruptions during playback.

Clipping

If the input signal is too high for your soundcard 'clipping' can occur and the signal is truncated. If the 
overload is severe, the result is an unpleasant distorted crackling sound. Clipping can be avoided by 
using the Auto Level feature to set the volume control to a suitable level.

Because a sample that has the maximum value cannot be distinguished from one that has been 
truncated it is impossible for LP Recorder to differentiate between the two. As a best guess, LP Recorder 
designates a clip as being three successive samples with the maximum value on the same stereo 
channel. The count of clips is displayed on the status bar. It is also logged with the corresponding track 
time in the trace file.    If the count of clips is only one or two, you can usually ignore them as distortion is 
unlikely to be noticeable.

The maximum level (peak) since the volume was last adjusted is also displayed on the status bar.

NOTE: You can reset the peak level, skip and click counters, at any time, by clicking on the status bar.



LP Ripper

If you are creating MP3 files or music CDs from your vinyl LPs you will need to save each track as a 
separate WAV file. 

LP Ripper is a companion program from CFB Software which makes this task much easier. Just record 
each side of your LP as a single WAV file with LP Recorder. LP Ripper automatically splits the file into a 
separate WAV file for each track, and optionally calls your MP3 Encoder to produce an MP3 file for each 
track. 

Download the trial version from the CFB Software website at:

http://www.cfbsoftware.com.au

Additional Features

· Listen to any track before you process it using the preview.

· Use the visual editing feature to trim the start and end of each track to a precision of 0.1 seconds.

· Replace the hiss between tracks with silence.

· The MP3 encoded LP takes up about 30-40 Mbytes. Typically you can store the equivalent of 2-3 
LPs on a 100Mb Zip disk or more than a dozen LPs on a single CD. 

· Track names can be edited using the full 255 characters of Windows’ long file names even if your 
MP3 Encoder does not support them.



· LP Ripper can use the Tracks (TRK) File that LP Recorder can generate - it then doesn't have to 
spend time reading the WAV file before it analyses it.

How does LP Ripper work?

LP Ripper calculates the length of each track by detecting the gap between tracks and displays a track 
listing showing the time of each track. You can then select which track(s) you want to save as separate 
WAV or MP3 files.

Some LPs have little or no gaps between tracks; others have long quiet sections that could be mistaken 
for a gap. LP Ripper lets you change the times that it has calculated and automatically adjusts the length 
of the remaining tracks.



Tracks (TRK) File
If you have checked the Use Tracks File checkbox, when you exit LP Recorder or go to record a different 
WAV file, LP Recorder will create a 'tracks' file with the same name as the current WAV file, with a TRK 
extension. E.g. if the WAV file is called myfile.wav the tracks file will be called myfile.trk. 

The tracks file saves a summary of the WAV file that can be used by LP Ripper. This saves time because 
LP Ripper does not have to spend time reading the WAV file again before it analyses it.

NOTE: Both the WAV file and the TRK file are located in the same directory. 



Troubleshooting
The meter display is not working
The recorded file just contains silence
If you can hear your LP playing through the computer speakers but the level meter displays nothing and 
the recorded file just contains silence, check that your recording input is enabled in Windows by setting 
the Windows Recording Control

LP Recorder has terminated.
WAV device not supported
If you get this error message when you start LP Recorder your preferred Recording device is not set to a 
suitable WAV device. 

1. Using Windows Control Panel, select MultiMedia

2. Click on the Audio tab. 

3. Make sure that the recording device is set to the Wave Input device of your soundcard. An example 
showing three input devices is:

SB16 Wave in [220]
Game Compatible Device
Voice Modem Wave #00 Line

SB16 Wave In would need to be selected for it to work - check the documentation that came with your 
soundcard if you need any more information.

The recording stops after a few seconds.
Uncheck the Auto Start / Stop checkbox to disable the Auto Stop feature. See Auto Start / Stop for 
information on how to use this feature.

The CD Writer does not recognise the WAV file
Make sure you give the WAV file a name with a .wav extension e.g. myfile.wav

Trace File
Whenever LP Recorder is terminated it saves a 'trace' file called LPRTrace.txt in your Windows temporary 
files directory (e.g. C:\WINDOWS\TEMP)

If you encounter a problem that you are unable to solve, email a copy of this trace file to technical support 
at:

info@cfbsoftware.com.au

with a description of what you were trying to do when the error occurred. 



New - File Menu
Select the New menu command to specify the location and name of the WAV file that you are recording. 
The Filename and Directory display boxes are updated and the available recording time, based on the 
amount of free disk space on the drive, is displayed.



Exit - File Menu
Select Exit to terminate LP Recorder and return to Windows.



Preferences - Options Menu
Set the preferences to suit your system.

Warn when recording over file
Check this setting if you don't want to accidentally record over an existing file. When you press the record 
button, LP Recorder warns you that the file exists and ask you if you want to delete it. If you click on No 
the recording is cancelled.

Start / Stop Level
This value is used with Auto Start / Stop. It represents the difference in level between the silence when 
the stylus is not in contact with the LP and the silence at the beginning of the LP. The default value is 200. 
To determine a suitable value for your system:

1. Connect your stereo to your soundcard and start LP Recorder
2. Set the LP Recorder volume level to mid-range
3. Observe the level value displayed in the status bar
4. Lower the stylus onto the beginning of an LP
5. Observe the level value displayed in the status bar

A suitable value is halfway between the values in (3) and (5)

e.g.    if the level is 196 when the stylus is raised, and 804 when it is lowered, a suitable level is:

(804 - 196) / 2 which is approximately 300. This value is close enough to use.

Use Tracks File
If this box is checked, when you exit LP Recorder or start recording a different WAV file, LP Recorder will 
create a Tracks File.



How to Order LP Recorder
LP Recorder V4.0 © Copyright 2000-2001. CFB Software. All Rights Reserved.

LP Recorder is a 32-bit program designed for use with Windows 95, 98, ME and NT4. It should also work 
on Windows 2000 but is untested at the current time.

Trial Version

The trial version of LP Recorder is free. It has all of the features of the full program except that recordings 
terminate after 5 minutes. You are free to distribute the trial version. It may be given away to friends, 
included on CD-ROM libraries, uploaded to Internet Web sites, ftp sites and bulletin boards, etc. as long 
as it is distributed in its complete original form. 

How to Order

You can order the full version of LP Recorder on-line in $US or Euro currency using:

Credit card
Visa
MasterCard
American Express
Diners Club
Eurocard

Wire transfer
EuroCheque
Cash.

Go to the CFB Software Web page at: 

www.cfbsoftware.com.au

Select the LP Recorder page from the index and select Order from the menu. Follow the instructions 
there.

Once your order has been forwarded to CFB Software, your Registration Details will be e-mailed to you. 
This will normally be within 24 hours.

If you want to order by mail using cash or a cheque in US, Australian or UK currency, send an e-mail to:

      info@cfbsoftware.com.au 

for the latest information. 

Technical Support

If you need technical support send an e-mail saying which version of LP Recorder you are using and 
include a description of the problem and the steps required to reproduce it to:

    info@cfbsoftware.com.au



If the problem is related to producing the WAV file, include a copy of the corresponding Tracks File. DO 
NOT send the WAV file as these are normally too large to handle.



Entering the Registration Details
When you have received your Registration details, start LP Recorder, select Register from the Help menu 
and enter the details.

As soon as you have entered the correct details, the 5 minute restriction on the length of the recording is 
removed. The length of the recording is only limited by the amount of free disk space or any Windows 
limit on file size.




